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Abstract
Defocusing Microscopy (DM) is a quantitative phase contrast microscopy technique based
on the propagation of the electrical field through the microscope, which is used to obtain
morphological and biomechanical parameters of different cells. On this dissertation, a
geometrical model of the surface of a red blood cell was used to make a proof of concept for
the total 3D reconstruction using DM. Furthermore, a new model for the angular spectrum
of a phase object was studied and compared with the one used in previous works. Finally,
we were able to make a computational routine to achieve the total 3D reconstruction of
red blood cells in mediums with different osmolalities. Using this new routine, the results
were obtained in 0.4s with high accuracy, representing an improvement from previous
results, and enabling the total 3D reconstruction in real time.

Key-words: Defocusing microscopy, 3D total reconstruction, Red blood cells, Real time.



Resumo
A Microscopia de Desfocalização (MD) é uma técnica de microscopia de contraste de fase
quantitativa baseada na propagação do campo elétrico pelo microscópio, que é utilizada
para obter parâmetros morfológicos e biomecânicos de diferentes células. Neste trabalho,
foi utilizado um modelo geométrico para a superfície de uma hemácia a fim de realizar
uma prova de conceito para a reconstrução 3D total utilizando-se da MD. Além disso, foi
estudado um novo modelo para o espectro angular de um objeto de fase e comparado o
contraste obtido anteriormente e o obtido atualmente. Por fim, uma rotina computacional
foi desenvolvida para a reconstrução 3D total de hemácias em meios com diferentes
osmolalidades. Utilizando o programa, resultados são obtidos em cerca de 0.04s com alta
acurácia, um avanço ao obtido anteriormente, e que viabiliza a reconstrução de células em
tempo real.

Palavras-chave: Microscopia de Desfocalização, Reconstrução 3D de células, Hemácias,
Tempo Real.
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1 Introduction

Quantitative phase contrast microscopy is a powerful optical microscopy technique
that seeks to non-invasively measure the morphology and dynamics of phase objects. One
of the great advantages of using this type of microscopy is the ease of sample preparation
when compared, for example, to fluorescence microscopy, and the increase in quantitative
information obtained when compared to phase contrast microscopy methods, such as the
discovery by Zernicke [1].

With quantitative phase contrast, the difference in refractive index between the
analyzed object and the medium is used to create contrast in a previously transparent
object, and can be divided into two groups: interference methods, which use interference
between a reference laser and one that is scattered by the phase object [2] [3] [4] [5]; and
non-interferometric methods, which reconstruct amplitude and phase information from
the field scattered by a phase object in specific lighting situations [6] [7] [8].It is important
to note that all phase contrast microscopy methods are, by nature, interferometric, since
they are based on the interference of light directly transmitted through the sample with
light scattered by it. The nomenclature used is simply to differentiate between techniques
that actively use an interferometer and those that do not. Currently, there is an effort to
integrate artificial intelligence into quantitative phase contrast microscopy techniques in
order to improve the results obtained and facilitate the experimental process for obtaining
the desired parameters. [9]. Various quantitative phase contrast microscopy techniques,
both interferometric and non-interferometric, can be found in the book Quantitative Phase
Imaging of Cells and Tissues [10]. Defocusing microscopy is a quantitative phase contrast
microscopy technique developed and used at the Biological Systems Physics Laboratory
of the Physics Department at UFMG that can be used to measure both biomechanical
parameters and the morphology of phase objects. This work focuses on the analysis of
the morphology of red blood cells in media with different osmolalities (a measure of the
concentration of ions present in 1 kg of solution, a quantity used for the concentration of
biological samples). Red blood cells were chosen for the study because they are easy to
obtain, being collected by students in the laboratory, and because they have a particular
characteristic: the absence of organelles inside them, which makes their refractive index
constant and already known in the literature. [11] [12]. Chapter 2 briefly demonstrates the
theory behind the construction of contrast used in defocusing microscopy, as well as a new
model for the angular spectrum of any phase object, which results in an improvement in
the expression of contrast used previously. In addition, a model for the surface of a red
blood cell is presented, which is used to test computational routines. Chapter 3 presents the
methodology used in this work, from the preparation of media with different osmolalities
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to the computational work for acquiring parameters from the collected microscopy images.
Chapter 4 presents the results obtained, which are total three-dimensional reconstructions
of red blood cells in hypotonic, isotonic, and hypertonic media. Chapter 5 presents the
conclusions and perspectives of the work. Finally, Appendix A contains the computational
routine written in the python language used to generate three-dimensional profiles of red
blood cells and extract the parameters of mean radius, volume, sphericity and surface
area. Appendix B contains a guide on how to obtain 3D reconstruction using the imageJ
software, commonly used for image analysis in the scientific community.
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2 Theoretical Background

2.1 Defocusing Microscopy

Defocusing Microscopy (DM) is a quantitative phase contrast technique that can be
used to analyze biomechanical and geometric parameters of phase objects. In this chapter,
we will calculate the contrast generated by a phase object, analyzing the effect of one
surface and two surfaces. We will also introduce an improvement on the model for the
angular spectrum of a phase object with two surfaces, generating a new expression for this
contrast. In addition, we will show how to recover the surfaces that make up this phase
object using the DM contrast on two different focal planes.

To formulate the contrast expressions, let’s start with Maxwell’s equations and
a brief review Fourier optics, and propagate the electric field through the defocused
microscope.

Maxwell’s equations in media without free charges are:

∇ · E⃗ = 0; (2.1)
∇ · B⃗ = 0; (2.2)

∇ × E⃗ = −∂B⃗

∂t
; (2.3)

∇ × B⃗ = µε
∂E⃗

∂t
. (2.4)

To find the wave equation, we calculate the curl of the equation 2.3:

∇ ×
(
∇ × E⃗

)
= −

∂
(
∇ × B⃗

)
∂t

. (2.5)

Using the identity ∇ × (∇ × A⃗) = ∇(∇ · A⃗) − ∇2A⃗ alongside the equations 2.1 e
2.4:

−∇2E⃗ = −µε
∂2E⃗

∂t2 . (2.6)

We have then successfully derived the wave equation. Assuming that the solution
is a monochromatic plane wave of the kind E⃗(r⃗, t) = E⃗(r⃗)eiωt and substituting it on 2.6:

∇2E⃗(r⃗) = ω2µεE⃗(r⃗). (2.7)
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Using v = 1/
√

µε, and k = ω/v, we get the Helmholtz equation:

∇2E⃗(r⃗) + k2E⃗(r⃗) = 0. (2.8)

In a linear, isotropic, and homogeneous medium, we can consider that the electric
field is the same in all directions. With this, we can consider 2.8 as a group of three
identical scalar equations, one for each direction in space. This approximation is called
the Scalar Theory of Diffraction, and we will use it for the propagation of the electric field
in the microscope, together with Fourier optics.

2.1.1 Fourier Optics

First, let’s define the Fourier transform F . It is a mathematical tool that allows us
to break down functions into the different frequencies and amplitudes that make them up.
Mathematically, the two-dimensional Fourier transform is given by:

F [f(x⃗)] = f̃(k⃗) =
∫ ∞

−∞
f(x⃗)e−ik⃗·x⃗d2ρ (2.9)

and the inverse transform:

F−1
[
f̃(k⃗)

]
= f(x⃗) = 1

(2π)2

∫ ∞

−∞
f̃(k⃗)eik⃗·x⃗d2k. (2.10)

Let’s now define some important properties of the Fourier transform:

1. Linearity: F [αf + βg] = αF [f ] + βF [g];

2. Similarity theorem : F [f(αρ)] = 1
|α|2 f̃

(
q
α

)
;

3. Translation theorem: F [f(ρ − α)] = f̃(q)e−iqα;

4. Rayleigh’s theorem (or Parseval’s theorem):
∫∞

−∞ |f(ρ)|2d2rρ =
∫∞

−∞ |f̃(q)|2d2q;

5. Convolution theorem: F [g ∗ f ] = F [g] · F [f ];

6. Derivadas: F [∇f(ρ)] = (−iq)F [f(ρ)];

It is also important to define the angular spectrum of the electric field, given by its
Fourier transform:

A(q⃗, z) =
∫

E(ρ⃗, z)e−iq⃗·ρ⃗d2ρ, (2.11)

and also the field as the inverse Fourier transform of the angular spectrum:
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E(ρ⃗, z) = 1
(2π)2

∫
A(q⃗, z)eiρ⃗·q⃗d2q, (2.12)

with ρ⃗ = xî + yĵ in the real space, and q⃗ = qxî + qy ĵ in Fourier space, the spatial
components in the plane perpendicular to the one of light propagation. Now we can define
the propagation of light through the various components of the microscope.

2.1.1.1 Free space propagation

To find the equation for the free propagation of the angular spectrum, we just need
to solve the Helmholtz equation 2.8 using the definition of the electric field as the inverse
transform of the angular spectrum, that is, using equation 2.12. That is:

∇2
(

1
(2π)2

∫
A (q⃗, z) eiρ⃗·q⃗d2q

)
+ k2

(
1

(2π)2

∫
A (q⃗, z) eiρ⃗·q⃗d2q

)
= 0. (2.13)

Calculating the second derivatives and reorganizing:

1
4π2

∫ [(
k2 − q2 + ∂2

∂z2

)
A (q⃗, z)

]
eiρ⃗·q⃗d2q = 0. (2.14)

The only way this expression can be null is if the integrand is null. Defining
k2

z = k2 − q2, we have:

−k2
zA (q⃗, z) = ∂2A (q⃗, z)

∂z2 , (2.15)

which has the following solution:

A (q⃗, z) = A (q⃗, 0) e±ikzz = A (q⃗, 0) e
±ikz

√
1− q2

k2 . (2.16)

The sign of the exponential function dictates the direction of light propagation.
In this work, we will adopt the positive sign for propagation in the direction of the
microscope’s optical axis. We can then see that, when propagating the angular spectrum,
we are adding a phase proportional to the distance traveled from our initial angular
spectrum position. Finally, considering that the angle of light propagation and the optical
axis is small, that is, q2 << k2, we can make the approximation

√
1 − q2

k2 ≈ 1 − q2

2k2 . Thus,
we have the final expression for the propagation of the angular spectrum in free space:

A (q⃗, z) = A (q⃗, 0) e±ikzz = A (q⃗, 0) e ikze−i zq2
2k . (2.17)

To find the electric field, we just need to calculate the Fourier transform:
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E(ρ⃗, z) = k

2πiz
eikz

∫
E(ρ⃗′, 0)e ik

2z
(ρ⃗−ρ⃗′)2

d2ρ′. (2.18)

2.1.1.2 Propagation through a thin lens

A thin lens only performs a transformation on the field’s phase. The electric field,
immediately after a thin lens, is given by:

El (ρ⃗) = tl(ρ⃗)E0(ρ⃗), (2.19)

where tl(ρ⃗) is the transmissivity of the lens, and is equal to:

tl(ρ⃗) = eiϕ(ρ⃗), (2.20)

where

ϕ(ρ⃗) = k0nm∆0 + k0(nl − nm)∆(ρ⃗). (2.21)

With nm being the refractive index of the media, and nl the refractive index of the
lens. ∆(ρ⃗) and ∆0 can be defined by dividing the lens into three parts: one convex, one
flat, and one concave, as illustrated in Figure 1. The thicknesses of these parts are:

Figure 1 – Diagram of a lens.

∆1(ρ⃗) = ∆01 − r1

(
1 −

√
1 − ρ2

r2
1

)
; (2.22)

∆2(ρ⃗) = ∆02; (2.23)

∆3(ρ⃗) = ∆03 + r2

(
1 −

√
1 − ρ2

r2
2

)
. (2.24)
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We can again make the paraxial approximation, as in the case of free propagation,√
1 − ρ2

R2
i

≈ 1 − ρ2

2R2
i
. Thus, we are left with:

∆(ρ⃗) = ∆0 − ρ2

2

( 1
r1

− 1
r2

)
. (2.25)

Substituting 2.25 on 2.21, we obtain:

ϕ(ρ⃗) = k0nl∆0 − k0(nl − nm)ρ2

2

( 1
r1

− 1
r2

)
. (2.26)

Using the Lensmaker’s equation, given by:

1
f

= nl − nm

nm

( 1
r1

− 1
r2

)
, (2.27)

wwe can finally write our phase ϕ(ρ⃗) as:

ϕ(ρ⃗) = k0nl∆0 − k

2f
ρ2. (2.28)

So, the electric field just after the lens, removing the terms that give us a constant
phase change, is given by:

El(ρ⃗) = E0(ρ⃗)e−i k
2f

ρ2
. (2.29)

To find the angular spectrum, we simply take the Fourier transform of 2.29:

A(q⃗, z) = F
[
E0(ρ⃗)e−i k

2f
ρ2
]

. (2.30)

Using the convolution theorem, we get:

A(q⃗, z) = 1
4π2

{
F [E0(ρ⃗, z)] ∗ F

[
e−i k

2f
ρ2
]}

A(q⃗, z) = f

2πik

∫
A0(q⃗′, z)ei f

2k (q⃗−q⃗′)2

d2q′. (2.31)

With this, we are ready to propagate the electric field in the defocused microscope.

2.1.2 Electrical field propagation in the defocused microscope

Using equations 2.17, 2.31, and 2.29, we can propagate the electric field through
the defocused microscope, as shown in image 2:
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Figure 2 – Representation of the defocused microscope.

Let’s divide the propagation into five parts:

1. Electric field E0 from the sample propagates to the objective lens, becoming E1;

2. Electric field E1 passes through the objective lens, with focal length f1, and becomes
E2;

3. Electric field E2 just after the objective lens is propagated through free space to the
tube lens, becoming E3;

4. Field E3 passes through the tube lens, with focal length f2, becoming E4;

5. Field E4 propagates to the image plane, becoming E5.

2.1.2.1 Field propagation to the objective lens

To propagate the field over a distance f1 − zf , we can use equation 2.18 to find the
field E1, and equation 2.17 to find its angular spectrum. We then have, for the electric
field:

E1(ρ⃗) = k

2πi(f1 − zf )eik(f1−zf )
∫

E0(ρ⃗′)e
ik

2(f1−zf ) (ρ⃗−ρ⃗′)2

d2ρ′. (2.32)

And for the angular spectrum:

A1(q⃗) = A0(q⃗)eik(f1−zf )e−i
q2(f1−zf )

2k . (2.33)

2.1.2.2 Electric field after the objective lens

Now, we use equation 2.29 to find the field after the objective lens:

E2(ρ⃗) = E1(ρ⃗)e
−ik
2f1

ρ2
. (2.34)

And the equation 2.31 to find its angular spectrum:
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A2(q⃗) = f1

2πik

∫
A1(q⃗′)e

if1
2k

(q⃗−q⃗′)2
d2q′. (2.35)

2.1.2.3 Propagation of the electric field to the tube lens

Again, we propagate the field through free space, now for a distance d using
equation 2.18:

E3(ρ⃗) = k

2πid
eik0d

∫
E2(ρ⃗′)e

ik0
2d

(ρ⃗−ρ⃗′)2
d2ρ′. (2.36)

and the angular spectrum using equation 2.17:

A3(q⃗) = A2(q⃗)eik0de
−iq2d

2k0 . (2.37)

2.1.2.4 Electric field after the tube lens

Now, we use equation 2.29 to find the field after the microscope’s tube lens:

E4(ρ⃗) = E3(ρ⃗)e
−ik0
2f2

ρ2
. (2.38)

And, using equation 2.31, we obtain the angular spectrum:

A4(q⃗) = f2

2πik0

∫
A3(q⃗′)e

if2
2k0

(q⃗−q⃗′)2
d2q′. (2.39)

2.1.2.5 Final electrical field

Finally, we need to propagate the field by a distance f2 to the detector, where the
image is formed. To do this, we use equation 2.18:

E5(ρ⃗) = k0

2πif2
eik0f2

∫
E4(ρ⃗′)e

ik0
2f2

(ρ⃗−ρ⃗′)
d2ρ′. (2.40)

And using equation 2.17, we also obtain the final angular spectrum:

A5(q⃗) = A4(q⃗)eik0f2e
−i

q2f2
2k0 . (2.41)

We now need to relate our final field E5 to our initial field E0, or our initial angular
spectrum A0. To do this, we start by substituting E4 into E5, and continue successively
until we obtain our initial expression. The process is described in more detail in the
appendix of [13]. We are left with:
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E5(ρ⃗) = J
∫

A0
(
ρ⃗′
)

ei
zf
2k

ρ′2
e

− if1k0
f2k

ρ⃗·ρ⃗′
d2ρ′, (2.42)

where J is:

J(ρ⃗) = −k0f1

4kf2π2 ei[k0(f2+d)+k(f1−zf )]ei
k0
2f2

(
1− d

f2
+ f1k0

f2k

)
ρ2

. (2.43)

We can see that when the focal plane is at the center of the phase object, i.e.,
zf = 0, the electric field has the form:

E5(ρ⃗) = J
∫

A0(ρ⃗′)e−i
f1k0
f2k

ρ⃗·ρ⃗′
d2ρ′ = E0

(
−f1k0

f2k
ρ⃗

)
, (2.44)

which is just the original electric field with a change of scale. We then see that,
as expected, the phase object only adds a phase to the electric field, not changing the
intensity measured in the microscope, unless the sample is defocused.

2.1.3 Angular spectrum of a phase object

2.1.3.1 Phase object with one interface

First, let us consider a flat phase object with a single interface, as shown in Figure
3.

Figure 3 – Phase object with a single interface.

Considering the phase object to be approximately flat, we can say that its thickness
is given by its average width l in addition to a small variation h(ρ⃗). We can also say
that the refractive index of the phase object is close to that of the medium nm, being
nc = nm + ∆n. Therefore, considering only the terms that depend on position, the phase
that light gains when passing through this type of object is
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ϕ(ρ⃗) = nmk0h(ρ⃗) − (nm + ∆n) k0h(ρ⃗) = ∆nk0h(ρ⃗). (2.45)

Assuming that the light arriving at the sample is a monochromatic plane wave,
the electric field immediately after the sample is:

E(ρ⃗) = E0e
iϕ(ρ⃗) = E0e

i∆nk0h(ρ⃗). (2.46)

Considering again that h(ρ⃗) is small, we can write the electric field as:

E(ρ⃗) = E0 (cos(∆nk0h(ρ⃗) + isen(∆nk0h(ρ⃗)) ≈ E0 (1 + i∆nk0h(ρ⃗)) . (2.47)

To find the initial angular spectrum, we just need to take the Fourier transform of
2.47:

A0(q⃗) = F [E(ρ⃗)] = E0
(
4π2δ(q⃗) + i∆nk0F [h(ρ⃗)](q⃗)

)
(2.48)

Substituting this angular spectrum into 2.42, we obtain:

E(ρ⃗) = J
∫

E0
(
4π2δ(q⃗) + i∆nk0ĥ(ρ⃗′)

)
ei

zf
2k

ρ′2
e

− if1k0
f2k ρ⃗ · ρ⃗′d2ρ′

E(ρ⃗) = JE0

[
4π2 + i∆nk0

∫
ĥ(ρ⃗′)ei

zf ρ′2

2k e
− if1k0

f2k
ρ⃗·ρ⃗′

d2ρ′
]

. (2.49)

In the small defocus regime (zf small), we can expand the first exponential of the
integral in 2.49, resulting in:

E(ρ⃗) = JE0

{
4π2 + i∆nk0

[∫
ĥ(ρ⃗′)e− if1k0

f2k
ρ⃗·ρ⃗′

d2ρ′ +
∫

ĥ(ρ⃗′)izf

2k
ρ′2e

− if1k0
f2k

ρ⃗·ρ⃗′
d2ρ′

]}
. (2.50)

Rewriting the first integral, we can easily identify it as an inverse Fourier transform
for F [h(ρ)]:

∫
h̃(ρ⃗′)e− if1k0

f2k
ρ⃗·ρ⃗′

d2ρ′ =
∫

h̃(ρ⃗′)ei

(
−f1k0

f2k

)
ρ⃗·ρ⃗′

d2ρ′ = (2π)2h

(
−f1k0

f2k
ρ⃗

)
(2.51)

To solve the second integral we can use the derivative property 6 of the Fourier
transform:∫

ĥ(ρ⃗′)izf

2k
ρ′2e

−if1k0
f2k

ρ⃗·ρ⃗′
d2ρ′ = −izf

2k

(
f2k

f1k0

)2

∇2
ρ

∫
ĥ(ρ⃗′)e

−if1k0
f2k

ρ⃗·ρ⃗′
d2ρ′ = −izf

2k

(
f2k

f1k0

)2

∇2
ρh

(
−f1k0

f2k
ρ⃗

)
.

(2.52)
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So, we have the following as our final field:

E(ρ⃗) = 4π2JE0

1 + i∆nk0h

(
−f1k0

f2k
ρ⃗

)
+ ∆nzfk

2k0

(
f2

f1

)2

∇2h

(
−f1k0

f2k
ρ⃗

) . (2.53)

The intensity observed on the detector becomes:

I(ρ⃗) = |E(ρ⃗)|2 ≃ I0

1 − zF
∆n

n0

(
kf2

k0f1

)2

∇2h

(
−f1k0

f2k
ρ⃗

) , (2.54)

where n0 is the reefractive index of the objective oil. We can define the contrast of an
image by:

C(ρ⃗) = I − I0

I0
. (2.55)

So, for a phase object with an single interface:

C(ρ⃗) = −zf
∆n

n0

(
kf2

k0f1

)2

∇2h

(
−f1k0

f2k
ρ⃗

)
. (2.56)

2.1.3.2 Phase object with two interfaces

First, let’s calculate the angular spectrum of a phase object with two roughly flat
interfaces, as shown in image 4.

Figure 4 – Phase object with two interfaces.

To propagate the angular spectrum through the object with two interfaces, we will
use three steps: Propagation through the first interface, gaining a phase Φ1 = ik0∆nh1;
Propagation over a distance p2 − p1 between the interfaces; Propagation through the
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second interface, gaining a phase Φ2 = ik0∆nh2. The field at each step is given by:

E1(ρ⃗) = E0e
i∆nk0h1(ρ⃗); (2.57)

E2(ρ⃗) = keik(p1−p2)

2πi(p1 − p2)

∫
E1(ρ⃗′)e

ik
2(p1−p2) (ρ⃗−ρ⃗′)2

d2ρ′; (2.58)

E3(ρ⃗) = E2(ρ⃗)ei∆nk0h2(ρ⃗). (2.59)

Assuming the incident field as a monochromatic plane wave of constant amplitude,
the field E3(ρ⃗) will be:

E3(ρ⃗) = E0
keik(p1−p2)ei∆nk0h2(ρ⃗)

2πi(p1 − p2)

∫
ei∆nk0h1(ρ⃗′)e

ik
2(p1−p2) (ρ⃗′−ρ⃗)2

d2ρ′. (2.60)

We can expand the exponentials containing h1(ρ⃗′) and h2(ρ⃗) in series and collect
only the first terms, assuming that the interfaces are sufficiently thin. We are then left
with:

E3(ρ⃗) = E0
keik(p1−p2)

2πi(p1 − p2)
(1+i∆nk0h2(ρ⃗))

[
−2π(p2 − p1)

ik
+ i∆nk0

∫
h1(ρ⃗′)e

ik
2(p1−p2) (ρ⃗′−ρ⃗)2

d2ρ′
]

.

(2.61)

Disregarding the term of order h1h2, we obtain:

E3(ρ⃗) = eik(p1−p2)
[
1 + i∆nk0h2(ρ⃗) + i∆nk0k

2πi(p1 − p2)

∫
h1(ρ⃗′)e

ik
2(p1−p2) (ρ⃗′−ρ⃗)2

d2ρ′
]

. (2.62)

Taking the Fourier transform, we can find the angular spectrum for a phase object with
two interfaces:

A3(q⃗) = E0e
ik(p1−p2)

[
4π2δ(q⃗) + i∆nk0ĥ2(q⃗) + i∆nk0ĥ1(q⃗)e

−i(p1−p2)
2k

q2
]

. (2.63)

Performing the same procedure as in the previous subsection, we can obtain the
contrast for an object with two flat interfaces:

C(ρ⃗) = (zf − p1)
∆n

n0

(
kf2

k0f1

)2

∇2h1

(
−k0f1

kf2
ρ⃗

)
+ (zf − p2)

∆n

n0

(
kf2

k0f1

)2

∇2h2

(
−k0f1

kf2
ρ⃗

)
.

(2.64)

In the case of a curved object, such as a red blood cell, we can simply replace
the positions of membranes p1 and p2 with the functions h1(ρ⃗) and h2(ρ⃗), respectively,
resulting in the coordinate system illustrated in Figure 5.
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Figure 5 – Coordinate system used for a curved phase object. Taken from [13].

Doing this and omitting scale factors to condense the notation, we are left with:

C(ρ⃗) = ∆n

n0

(
(∆f − h1(ρ⃗))∇2h1(ρ⃗) − (∆f − h2(ρ⃗))∇2h2(ρ⃗)

)
. (2.65)

By changing the variables to the thickness H(ρ) = h1(ρ) − h2(ρ) and asymmetry
ξ(ρ) = h1(ρ) + h2(ρ), we can rewrite the expression for the contrast as:

C(ρ) = ∆n

2n0

(
2∆f∇2H − H∇2ξ − ξ∇2H

)
. (2.66)

To find the thickness H(ρ), we must use two contrasts in different focal planes.
Subtracting them, we obtain:

∆C = ∆n

n0
(∆f1 − ∆f2)∇2H, (2.67)

which is a Poisson equation. Calculating the Fourier transform:

F [∆C] = ∆n

n0
(∆f1 − ∆f2)q2F [H]. (2.68)

Solving the equation for H(ρ):
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F [∆C] n0

∆n(∆f1 − Deltaf2)
= q2F [H]

F [H] = F [∆C]
q2

n0

∆n(∆f1 − ∆f2)

H = n0

∆n(∆f1 − ∆f2)
F−1

[
F [∆C]

q2

]
. (2.69)

To find the asymmetry ξ, we can use a contrast obtained in the focal plane, that
is, ∆f = 0. We are left with the following expression;

C(ρ) = −∆n

2n0

(
H∇2ξ + ξ∇2H

)
. (2.70)

Reorganizing:

∇2ξ + ∇2H

H
ξ = −2Cn0

∆n
. (2.71)

The equation has the form of a non-homogeneous Helmholtz equation with variable
coefficients, and there is no general analytical solution for it. It is a type of equation found
in seismology papers [14], and has an approximate analytical solution only in specific cases,
with the coefficient of ξ varying slowly [15], which cannot be guaranteed in our context.
The equation is solved numerically using the finite element method in this work. As we
will see below, there is a wide variation of solutions with small changes in the boundary
condition, which makes it difficult to process a large number of images. To solve this
problem, a new contrast expression was developed from a better angular spectrum model
for a phase object, presented in the next subsection.

2.1.4 Refinement of the model for the angular spectrum of a phase object

Another model for the angular spectrum of the electric field scattered by a phase
object can be found from the Helmholtz equation, and is discussed in detail in [16]. We
will derive it and use it to find a new contrast expression for defocusing microscopy.

The Helmholtz equation in a medium with a scattering object is given by:

∇2E(r⃗) + +k2n(r⃗)E(r⃗) = 0. (2.72)

We can rewrite equation 2.72 in a more convenient way:

∇2E(r⃗) + k2E(r⃗) = −4πF (r⃗)E(r⃗), (2.73)
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where F (r⃗) = k2[n2(r⃗) − 1]/k2 is called the scattering potential of the medium. Assuming
that the total electric field is given by the sum of the incident field and the scattered field,
i.e., E = Ei + Es, and that the incident field obeys the traditional Helmholtz equation, we
have:

(∇2 + k2)Es(r⃗) = −4πF (r⃗)E(r⃗). (2.74)

We can transform this equation into an integral equation using Green’s functions. We
have:

(∇2 + k2)G(r⃗ − r⃗′) = −4πδ(3)(r⃗ − r⃗′). (2.75)

Multiplying equation 2.74 by G(r⃗ − r⃗′), equation 2.75 by Es(r⃗) and subtracting
2.74 from 2.75 . We are left with:

Es(r⃗)∇2G(r⃗− r⃗′)−G(r⃗− r⃗′)∇2Es(r⃗) = 4πF (r⃗)E(r⃗)G(r⃗− r⃗′)−4πEs(r⃗)δ(3)(r⃗− r⃗′). (2.76)

Now we can integrate both sides of 2.76 into the variable r′ in a volume VR, bounded
by a sphere of surface area SR with radius R, which contains the scattering object inside,
as shown on figure 6:

Figure 6 – Scatering object with volume V delimited by a sphere with radius R. The sphere has volume
VR and surface area SR. The vector n′ is normal to the sphere.

Using Green’s theorem, we can convert the integral on the left side of 2.76 into a
surface integral, and after a simple manipulation, we obtain:

Es(r⃗) =
∫

V
F (r⃗′)E(r⃗′)G(r⃗ − r⃗′)d3r′ − 1

4π

∫
SR

Es(r⃗′)∂G(r⃗ − r⃗′)
∂n′ − G(r⃗ − r⃗′)∂Es(r⃗)

∂n′ dSR.

(2.77)
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We can make R −→ ∞, so that it is reasonable to assume that the second integral on
the right-hand side of 2.77 does not contribute to the scattered field. The chosen Green’s
function will be:

G(r⃗ − r⃗′) = eik|r⃗−r⃗′|

|r⃗ − r⃗′|
. (2.78)

Assuming that the incident field, coming from a direction ŝ0, is given by a plane
wave, that is, Ei = eikŝ0·r⃗, we are left with the following expression for the electric field:

E(r⃗) = eikŝ0·r⃗ +
∫

V
F (r⃗′)E(r⃗′)eik|r⃗−r⃗′|

|r⃗ − r⃗′|
d3r′. (2.79)

This is called the integral equation of potential scattering. We cannot solve this equation
directly, given the presence of the field itself within the integral, so we must resort to some
technique to perform an approximation. A valid method in these cases is the perturbative
method. Using it in the first order, we have:

E(r⃗) ≈ E(1)(r⃗) = eikŝ0·r⃗ +
∫

V
F (r⃗′)eikŝ0·r⃗′ eik|r⃗−r⃗′|

|r⃗ − r⃗′|
d3r′. (2.80)

The unit vector ŝ0 gives us the direction of the wave incident on the object. This solution
is called Born’s first-order approximation, and is sufficient for our application. In cases
where multiple scattering occurs, a second-order expansion is necessary. We can focus our
analysis on the second term of 2.80, which represents the scattered field. As we saw earlier,
we need the angular spectrum of the field scattered by the phase object to develop the
contrast of defocusing microscopy. Let us first deduce the angular spectrum for any object,
and then apply it to our specific case. We then have, for the scattered field:

E
(1)
S (r⃗) =

∫
F (r⃗′)eikŝ0·r⃗′ eik|r⃗−r⃗′|

|r⃗ − r⃗′|
d3r′. (2.81)

From now on, the subscript (1) related to the first order in Born approximation of
the scattered field will be omitted, since we will always be within this approximation. As
shown by H. Weyl in [17], we can write the spherical wave within the integral as:

eik|r⃗−r⃗′|

|r⃗ − r⃗′|
= ik

2π

∫∫ ∞

−∞

1
sz

eikŝ·(|r⃗−r⃗′|)dsxdsy, (2.82)

in which the unit vector ŝ gives the direction of the scattered wave and si is the i

component of this vector. Substituting 2.82 in 2.81, we get:

ES(r⃗) =
∫

V
F (r⃗′)eikŝ0·r⃗′

∫∫ ∞

∞

ik

2πsz

eik[ŝ·(r⃗−r⃗′)]dsxdsyd3r′. (2.83)
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We can reorganize the exponential terms of this integral in a more convenient way:

ES(r⃗) =
∫

V
d3r′

∫∫ ∞

∞
dsxdsy

ik

2πsz

F (r⃗′)e−ik[(ŝ−ŝ0)·r⃗′]eikŝ·r⃗

ES(r⃗) =
∫∫ ∞

∞
a(sx, sy)eikŝ·r⃗dsxdsy, (2.84)

in which a(sx, sy) is a term proportional to the Fourier transform of F (r′), at frequency
k(si − s0i):

a(sx, sy) =
∫

V

ik

2πsz

F (r⃗′)e−ik[(ŝ−ŝ0)·r⃗′]d3r′

= ik

2πsz

F̃ [k(sx − s0x), k(sy − s0y), k(sz − s0z)]. (2.85)

If we calculate the spatial Fourier transform in the x, y plane of 2.84, we obtain

As = (2π)2

k2 a(sx, sy)eikszz. (2.86)

Reorganizing:

a(sx, sy) = k2

(2π)2 Ase
−ikszz. (2.87)

We then obtain two expressions for the term a(sx, sy). Equating 2.85 and 2.87:

ik

2πsz

F̃ = k2

(2π)2 Ase
−ikszZ . (2.88)

We then have, as a general expression for the angular spectrum of the field scattered
by an object:

AS = 2πi

ksz

e−ikszZ
∫

F (r⃗)e−ik[(sx−s0x)x′+(sy−s0y)y′+(sz−s0z)z′]d3r′. (2.89)

With the general expression derived, we can derive the expression for a phase object
with two surfaces, as shown on figure 7.
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Figure 7 – Phase object located between 0 and Z. The surfaces h1(ρ) and h2(ρ) are the lower and upper
membrane of the phase object. The media refraction index is now denoted as nm and the phase
object’s nc.

We can assume that the wave strikes the phase object only in the z direction,
so s0x = s0y = 0. We will also change the notation to match the one used to find the
expression for the electric field in the image plane found earlier. That is, ksx + ksy = q

and x′ + y′ = ρ′. Substituting the expression for the scattering potential, we get:

As = 2πi

kz

e−ikzZ
∫ k0

4π
[n2(r′) − n2

m]e−iqρ′
e−i(kz−k0z)z′

dρ′dz′, (2.90)

where nm is the refractive index of the medium in which our phase object is inserted.
Looking at figure 7, we can see that the integral is non zero only in the regions between the
surfaces h1(ρ) and h2(ρ), since outside of it n(r′) = nm, zeroing the term in parentheses.
Being no the refractive index of the phase object, we have:

As = 2πi

kz

eikzZ
∫

d2ρ′ k0

4π
(n2

c − n2
m)e−iqρ′

∫ h2(ρ′)

h1(ρ′)
dz′ei(kz−k0z)z′

= 2πi

kz

eikzZ
∫

d2ρ′ k0

4π
(n2

c − n2
m)e−iqρ′ e−i(kz−k0z)h2 − e−i(kz−k0z)h1

−i(kz − k0z)

AS = 2πi

kz

eikzZ k0(n2
c − n2

m)
4π

∫
d2ρ′eiqρ′ e−i(kz−k0z)h2 − e−i(kz−k0z)h1

−i(kz − k0z) . (2.91)

Since we are working within the paraxial approximation, we have that kz =
√

k2
0 − q2 ≈
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k0(1 − q2/2k2
0). Thus, we can rewrite 2.91:

As = 2πi

kz

eik0Ze
−i q2z

2k0
k0(ns

c − n2
m)

4π

∫
d2ρ′e−iqρ′ 2k0

iq2

[
e

iq2
2k0

h2 − e
iq2
2k0

h1

]
. (2.92)

We now have the final equation for the angular spectrum of a phase object with
two interfaces. All that remains is to substitute it into equation 2.92 to find a new contrast
equation for an out-of-focus object. Recalling the final electric field of the defocused
microscope:

E(ρ⃗) =
∫

A0e
izf q2

2k e
−i

f1
f2

k0
k

ρq
d2q. (2.93)

Making the change nmk0 = km and substituting the equation found for the scattered
angular spectrum:

E(ρ⃗) =
∫

d2q
∫

d2ρ′ 2πi

km

eikmZe−i q2Z
2km

k0[n2
c − n2

m]
4π

e−iqρ′ 2k0

iq2

[
e

iq2
2k0

h2 − e
iq2
2k0

h1

]
e

izf q2

2k e
−i

f1
f2

k0
k

ρq
.

(2.94)

Reorganizing the terms and replacing the term kz in the denominator of the first
fraction with km, since before the scattering kz = km:

E(ρ⃗) = 2πi

km

eikmZe
i q2

2km
( nm

n0
zf −Z) k2

0[n2
c − n2

m]
4π

2km

iq2

∫
d2qeiρq

∫
d2ρ′e−iqρ′

[
e

iq2
2km

h2 − e
iq2

2km
h1
]

.

(2.95)

Grouping the terms with q2 in the exponent and simplifying:

E(ρ⃗) = ik0

2 eikmZ [n2
c − n2

m]
nm

2km

iq2

∫
d2qeiρq

∫
d2ρ′

[
e

iq2
2km

(
h2+ nm

n0
zf −Z

)
− e

iq2
2km

(
h1+ nm

n0
zf −Z

)]
,

(2.96)

where n0 is the refractive index of the objective oil. Now, we can move our origin
to the other end of our phase object, as shown in Figure 8.
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Figure 8 – Phase object with coordinate change.

Performing the change in equation 2.96:

E(ρ⃗) = ik0

2 eikmZ [n2
c − n2

m]
nm

2km

iq2

∫
d2qeiqρ

∫
d2ρ′e−iqρ′

[
e

iq2
2km

(
−h′

1+ nm
n0

zf

)
− e

iq2
2km

(
h′

2+ nm
n0

zf

)]
.

(2.97)
We then have a new expression for the final scattered field of defocusing microscopy. To
construct the contrast, we need the intensity. Since E = Ei + Es, we have:

I = |Ei|2 + E∗
i Es + E∗

s Ei + |Es|2. (2.98)

Within Born’s first approximation, we can disregard the term |Es|2. We have for contrast:

C = I − I0

I0
= |Ei|2 + E∗

i Es + E∗
s Ei − |Ei|2

|Ei|2
= Es

Ei

+ E∗
s

E∗
i

. (2.99)

Opening the complex fields in their real and imaginary parts, we get:

C = 2Re
{

Es

Ei

}
. (2.100)

Making the incident field as Ei = eikmZ/(2π)2, and making the changes h′
2 → h2,

h′
1 → h1 for notation purposes:
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Es

Ei

= 1
(2π)2

k0km

q2
[n2

c − n2
m]

nm

∫
d2qeiqρ

∫
d2ρ′e−iqρ′

[
e

iq2
2km

(
−h1+ nm

n0
zf

)
− e

iq2
2km

(
h2+ nm

n0
zf

)]
.

(2.101)

In the regime of thin objects and small defocusing, we can expand the exponentials
of 2.101 in Taylor series:

e
iq2

2km

(
−h1+ nm

n0
zf

)
≈ iq2

2km

(
−h1 + nm

n0
zf

)
− q4

8k2
m

(
−h1 + nm

n0
zf

)2
+ O3; (2.102)

e
iq2

2km

(
h2+ nm

n0
zf

)
≈ iq2

2km

(
−h2 + nm

n0
zf

)
− q4

8k2
m

(
−h2 + nm

n0
zf

)2
+ O3. (2.103)

Since we only want the real part, we will collect only the second term of each
expansion. Substituting in 2.101:

Es

Ei

= 1
(2π)2

k0km

q2
[n2

c − n2
m]

nm

∫
d2qeiqρ

∫
d2ρ′e−iqρ′ −q4

8k2
m

[(
−h1 + nm

n0
zf

)2
−
(

−h2 + nm

n0
zf

)2
]

= 1
(2π)2

[n2
c − n2

m]
n2

m

∫
d2qeiqρ

∫
d2ρ′e−iqρ′ −q2

8

[(
−h1 + nm

n0
zf

)2
−
(

−h2 + nm

n0
zf

)2
]

.

(2.104)

We can use the derivative property, given in equation 6, to make q2 → ∇2. Finally,
we identify the integrals as a Fourier transform and an inverse Fourier transform. Thus:

Es

Ei

= − [n2
c − n2

m]
8n2

m

∇2
[(

−h1 + nm

n0
zf

)2
−
(

−h2 + nm

n0
zf

)2
]

. (2.105)

Substituting it in the expression 2.100 found for the contrast:

C = [n2
m − n2

c ]
4n2

m

∇2
[(

−h1 + nm

n0
zf

)2
−
(

−h2 + nm

n0
zf

)2
]

. (2.106)

We can simplify this expression even further by expanding the notable products
within the Laplacian operator:

C = [n2
m − n2

c ]
4n2

m

∇2
[
h2

1 − 2nm

n0
h1zf +

(
nm

n0
zf

)2
−
(

h2
2 − 2nm

n0
h2zf +

(
nm

n0
zf

)2
)]

= [n2
m − n2

c ]
4n2

m

∇2
[
h2

1 − h2
2 − 2nmzf

n0
(h1 − h2)

]

= [n2
m − n2

c ]
4n2

m

∇2
[
(h1 − h2)(h1 + h2) − 2nmzf

n0
(h1 − h2)

]
. (2.107)



Chapter 2. Theoretical Background 31

Making the variable changes again: h1 − h2 = H and h1 + h2 = ξ:

C = [n2
m − n2

c ]
4n2

m

∇2
[
Hξ + 2nm

n0
zfH

]
. (2.108)

This is our final equation for the contrast of a phase object. We can see, if we
compare it with the expression 2.66, used previously, that we have a simpler expression,
now in the form of a Poisson equation. This allows us to find the morphological parameters
of phase objects more quickly and efficiently, making it possible to solve it analytically for
thickness H and asymmetry ξ.

To find the variables H and ξ, and consequently the surfaces h1 and h2, we must
first find the thickness H. To do this, we must capture two images at different focal planes,
subtract the contrasts, and solve a Poisson equation. Mathematically:

C1 − C2 = ∆C = [n2
m − n2

c ]
4n2

m

∇2
[2nm

n0
(zf1 − zf2)H

]
2nm

n0
∆zf∇2H = 4n2

m∆C

[n2
m − n2

c ]

∇2H = 2∆Cn0nm

[n2
c − n2

m]∆zf

F [H] = 2n0nm

[n2
c − n2

m]∆zf

F [∆C]

q2F [H] = 2n0nm

[n2
c − n2

m]∆zf

F [∆C]

F [H] = 2n0nm

[n2
c − n2

m]∆zf

F [∆C]
q2

H = 2n0nm

[n2
c − n2

m]∆zf

F−1
[

F [∆C]
q2

]
. (2.109)

In posession of H, we can find the asymmetry ξ. Taking an image on any focal
plane where the objects contrast is linear, we can find ξ as follows:

C = [n2
m − n2

c ]
4n2

m

∇2
[
Hξ + 2nm

n0
zfH

]
4n2

m

[n2
m − n2

c ]
C = ∇2

[
Hξ + 2nm

n0
zfH

]

4n2
m

[n2
m − n2

c ]
F [C] = q2

[
F [Hξ] + 2nm

n0
zfF [H]

]
4n2

m

[n2
m − n2

c ]
F [C]

q2 = F [Hξ] + 2nm

n0
zfH
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F [Hξ] = 4n2
m

[n2
m − n2

c ]
F [C]

q2 − 2nm

n0
zfF [H]

Hξ = 4n2
m

[n2
m − n2

c ]
F−1

[
F [C]

q2

]
− 2nm

n0
zfH

ξ = 4n2
m

H[n2
m − n2

c ]
F−1

[
F [C]

q2

]
− 2nm

n0
zf . (2.110)

Thus, by solving two Poisson equations, we obtain the surfaces of both membranes
of a phase object using only two images obtained at different focal planes. The membranes
are given by:

h1(ρ) = ξ + H

2 = 2n2
m

H[n2
m − n2

c ]
F−1

[
F [C]

q2

]
−nm

n0
zf + n0nm

[n2
c − n2

m]∆zf

F−1
[

F [∆C]
q2

]
(2.111)

h2(ρ) = ξ − H

2 = 2n2
m

H[n2
m − n2

c ]
F−1

[
F [C]

q2

]
− nm

n0
zf − n0nm

[n2
c − n2

m]∆zf

F−1
[

F [∆C]
q2

]
.

(2.112)

It is important to note another difference between the new and traditional equations:
previously, we made the approximation zf ≈ ∆f , such as in [18] [19], and considered the
minimum contrast plane at the center of the red blood cell with ∆f = 0. In this work, we
do not make this approximation, and as shown in Figure 5, zf is the distance from the
coverslip to the focal plane. The exact position of the lamella in the z-axis is extremely
difficult to locate experimentally, requiring the preparation of a lamella with polystyrene
microspheres, and that the microspheres be close to the sample at the time of image
capture, but far enough away so that there is no physical contact and the light scattered
by the sphere does not interfere with that scattered by the red blood cell.

Given this difficulty, as the term containing zf is only a constant that is subtracted
from the expression for each membrane, it only translates our total 3D reconstruction
vertically, without interfering with the obtention of any of the parameters that are of
interest for analysis. The experiments for the validation of the new equation were performed
with coverslips without polystyrene microspheres.

2.2 Geometric representation of the surface of a red blood cell

As a way to theoretically validate the use of defocusing microscopy to obtain
geometric reconstruction of cells, we use the geometric representation of red blood cells,
already well known and first demonstrated by Kuchel in [20] and explored in [21]. The
equation that better approximates the shape of a red blood cell is the one of a degree-4
surface, such as:
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(
x2 + y2 + z2

)2
+ P

(
x2 + y2

)
+ Qz2 + R = 0, (2.113)

in which the coefficients P , Q, and R are adjusted according to the geometric
characteristics of the red blood cell to be generated. To find the explicit forms of these
parameters, it is convenient to rewrite equation 2.113 in cylindrical coordinates:

(
ρ2 + z2

)2
+ Pρ2 + Qz2 + R = 0. (2.114)

The required red blood cell parameters are its diameter d, its maximum height h,
and its height at the center b, as shown on image 9.

Figure 9 – Red blood cell surface parameters. [20]

We can obtain three equations to determine P , Q and R as a function of b, d and
h, analyzing 3 points of interest in 9:

1. At the center ( ρ = 0 and z = b/2):

b4

16 + Q
b2

4 + R = 0 (2.115)

2. At the edges (ρ = d/2 e z = 0):

d4

16 + P
d2

4 + R = 0 (2.116)

3. At the maximum height point (ρ = ρc e z = h/2):

P 2 + h2(P − Q) − 4R = 0 (2.117)

If we solve 2.115 and 2.116 together, we obtain an equation for Q as a function of
P :

Q = P
d2

b2 + b2

4

(
d4

b4 − 1
)

. (2.118)

Using equation 2.116, we also arrive at an expression for R as a function of P :
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R = −d2

4

(
P + d2

4

)
. (2.119)

Substituting 2.118 and 2.119 into 2.117, we finally obtain an equation for P :

P 2 + h2P − h2
[
P

d2

b2 + b2

4

(
d4

b4 − 1
)]

+ d2
(

P − d2

4

)

P 2 + P

[
d2 − h2

(
d2

b2 − 1
)]

+
[

d4

4 − h2b2

4

(
d4

b4 − 1
)]

= 0. (2.120)

Equation 2.120 is a quadratic equation, so it has two solutions, denoted P+ and
P−:

P+ = −d2

2 + h2

2

(
d2

b2 − 1
)

− h2

2

(
d2

b2

)√
1 − b2

h2 ; (2.121)

P− = −d2

2 + h2

2

(
d2

b2 − 1
)

+ h2

2

(
d2

b2

)√
1 − b2

h2 . (2.122)

We then need to find which of the solutions for P gives us a value that is consistent
with the surface of a red blood cell. To do this, we can derive the expression 2.114 in ρ.
Doing so, we obtain:

4ρ
(
ρ2 + z2

)
+ 4z

dz

dρ

(
ρ2 + z2

)
+ 2Pρ + 2Qz

dz

dρ
= 0

2
(
ρ2 + z2

)(
ρ + z

dz

dρ

)
+ Pρ + Qz

dz

dρ
= 0. (2.123)

Looking again at Figure 9, which represents a meridional cross section of the surface,
we observe three points where dz

dρ
= 0: at the center of the red blood cell and at the two

points where ρ = ρc. To observe these points in the surface equation, we can set dz
dρ

= 0 in
equation 2.123:

2ρ
(
ρ2 + z2

)
+ Pρ = 0

ρ
(

ρ2 + z2 + P

2

)
= 0. (2.124)

we see that ρ = 0 satisfies this equation. Substituting ρ = ρc, and setting z = h/2
to analyze the maximum points:

ρ2
c + h2

4 = −P

2
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−
(

2ρ2
c + h2

2

)
= P. (2.125)

So we see, then, that for equation 2.113 to represent a biconcave erythrocyte, the
condition P < 0 must necessarily be satisfied. We need to choose between P+ and P−

the solution that presents P < 0 for the usual parameters d, h and b of a red blood cell.
This solution is P+, since in the region of interest of d > h > b, as is the case for the vast
majority of red blood cells, P+ < 0 always.

2.2.1 Surface plot

To plot the surface, we first need to solve equation 2.114 for z. Expanding the term
(ρ2 + z2)2 we get:

ρ4 + z4 + 2ρ2z2 + Pρ2 + Qz2 + R = 0

z4 +
(
2ρ2 + Q

)
z2 +

(
ρ4 + Pρ2 + R

)
= 0. (2.126)

We can see that equation 2.126 is a biquadratic equation for z. Substituting z2 = Z,
we are left with only one quadratic equation to solve:

Z2 +
(
2ρ2 + Q

)
Z +

(
ρ4 + Pρ2 + R

)
= 0. (2.127)

Solving it, we obtain the roots:

Z+ = − (2ρ2 + Q) +
√

∆
2 ; (2.128)

Z− = − (2ρ2 + Q) −
√

∆
2 , (2.129)

where ∆ is:
∆ =

(
2ρ2 + Q

)2
− 4

(
ρ4 + Pρ2 + R

)
∆ = 4ρ4 + Q2 + 4ρ2Q − 4ρ4 − 4Pρ2 − 4R

∆ = Q2 + 4ρ2Q − 4Pρ4 − 4R. (2.130)

Since z = ±
√

Z, and necessarily, z ∈ R since it represents the surface, the solution of
2.127 that interests us is 2.128. We are left with solutions for both membranes, with z+

denoting the upper membrane and z− the lower one.
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z+ =
√

Z+ =
[

− (2ρ2 + Q) +
√

∆
2

]1/2

; (2.131)

z− = −
√

Z+ = −
[

− (2ρ2 + Q) +
√

∆
2

]1/2

. (2.132)

Using the values of 8µm for the diameter, 2µm for the maximum height of the
surface, and 1µm for the minimum height, we obtain values of P = −15.12, Q = 56.12
and R = −14.10. We can finally plot the red blood cell model:

Figure 10 – Surface plotted using equations 2.131 and 2.132.

With the surface area, we can easily define the thickness H and asymmetry ξ for
the simulated red blood cell and reverse the process, generating the contrast with the
traditional expression 2.66 and the new expression 2.108.

2.3 Diffraction-limited systems

At no point during the propagation of the electric field in the defocused microscope
do we take into account that we are in a system limited by diffraction. This not problematic
when dealing with experimentally obtained images, but it will be a problem when we
calculate the contrast of a simulated phase object, so let us briefly construct the theory of
pupil functions and impulse response functions.

Every optical imaging system can be exemplified as shown on figure 11: an object,
a “black box” with two openings called pupils, one for input and one for output, which
contain all the optical components of the system, and a plane where the image is formed,
after the output pupil. The diffraction-limited system is defined as one in which each
point on the object plane generates a converging spherical wave, which is collected by the
entrance pupil, and in turn, the exit pupil generates a converging spherical wave to the
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image plane. Each point on the image plane can be related to the object plane by the
same magnification factor in the ideal case.

Figure 11 – Diffraction-limited system model. Taken from [22].

We need to study the effects of diffraction on image formation in the case of
monochromatic illumination. We can consider that inside the “black box” all effects can
be explained by geometric optics, so the entrance and exit pupils must be responsible for
the diffraction effects. Since the pupils are images of each other, we can consider that all
effects are created by only one of them. The first studies in this regard were conducted
by Abbe [23] in 1873, considering only the entrance pupil, and by Rayleigh [24] in 1896,
considering the exit pupil. Let us consider the view that diffraction effects are generated
solely at the exit pupil. The amplitude of the electric field in the image plane is given by:

Ei(u, v) =
∫∫ ∞

−∞
h(u, v; ξ, η)Eo(ξ, η)dξdη, (2.133)

in which Eo is the field in the plane of the object, h(u, v; ξ, η) is the amplitude
of the field at position (u, v) that was transmitted by the object at position (ξ, η). This
function is given by:

h(u, v; ξ, η) = A

λzi

∫∫ ∞

−∞
P (x, y)e

ik
zi

[(u−Mξ)+(v−Mη)]
dxdy, (2.134)

where P (x, y) is the pupil function of the exit aperture, located in the plane (x, y),
and M is the magnification given by the optical system. To leave equation 2.134 invariant,
we use the reduced coordinates ξ̃ = Mξ, and η̃ = Mη. Making this change:

h(u − ξ̃, v − η̃) = A

λzi

∫∫ ∞

−∞
P (x, y)e

−ik
zi

[(uξ̃)x+(v−η̃)y]dxdy. (2.135)

We can now define the ideal image Eg, which would be formed in a system not
limited by diffraction, given by geometric optics:

Eg(ξ̃, η̃) = 1
|M |

Eo

(
ξ̃

|M |
,

η̃

|M |

)
. (2.136)
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Using this concept, we obtain a convolution equation for the image:

Ei(u, v) =
∫∫ ∞

∞
h(u − ξ̃, v − η̃)Eg(ξ̃, η̃)dξ̃dη̃, (2.137)

Where:
h(u, v) = A

λzi

∫∫ ∞

∞
P (x, y)e− ik

zi
(ux+vy)

dxdy. (2.138)

We can identify h(u, v) as the Fraunhofer diffraction pattern of the exit pupil of our
system. Then, in the general case for monochromatic illumination, the image formed in a
diffraction-limited system is the convolution of the ideal image, given by geometric optics,
with the Fraunhofer diffraction pattern of the exit pupil.

Finding the exact pupil function of a microscope is extremely complex, requiring
techniques such as Fourier Pictography, demonstrated in the article [25], or open-field
fluorescence microscopy, as in [26].

As this is a highly complex issue that goes beyond the scope of this work, we will
make some approximations.

In the case of the microscope, it is reasonable to assume that all openings through
which light passes are circular, and are therefore defined by the function:

P (x, y) =

1, if
√

x2 + y2 ≤ R;

0, if
√

x2 + y2 > R,
(2.139)

where R is the effective pupil opening radius of the system. We can also write it as:

P (x, y) = circ

(√
x2 + y2

R

)
. (2.140)

The Fraunhofer diffraction pattern of a circular aperture is well known, given by:

h(u, v) = J1(r)
r

, (2.141)

Where r is the radius in the reciprocal plane, and J1 is the Bessel function of first
order. This function generates the Airy pattern, shown in the figure.12.
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Figure 12 – Airy pattern.

We can approximate the Airy disk by a circle centered on the central maximum,
that is:

h(fx, fy) = circ


√

f 2
x + f 2

y

R/λ.zi

 (2.142)

The quantity that now occupies the place of the radius of the function circ in 2.142 is
called the cutoff frequency fo and limits the possible spatial frequencies in our system
after diffraction. It is given by:

fo = R

λzi

. (2.143)
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3 Methodology

3.1 Experimental Setup

The experiments were conducted at the Physics of Biological Systems Laboratory
in the Physics Department at UFMG. The inverted optical microscope used was a Nikon
TI-E model, with a Nikon objective lens of 100x magnification and a numerical aperture
of 1.48. Two camera models were used to capture the defocusing microscopy images: an
EPIX camera, model SV643M CMOS, with a variable capture rate of up to 26636 frames
per second and a pixel size of 0.098µm on the objective lens used; and a UNIQ camera,
model UP1800 CL - 12 bits, with a CCD sensor, a capture rate of 15 frames per second,
and a pixel size of 0.064µm on the 100x objective lens. The equipment is shown in figure
13.

(a) TI-E microscope. (b) UNIQ camera used.

Figure 13 – Microscope and camera used during the experiments.

The microscope has a focus control system called PFS (Perfect Focus System),
which is essential for conducting the experiments, since one of the most important variables
is the difference between the focal planes of the acquired images. The camera primarily
used was a CCD sensor due to the higher image quality, since the low capture rate does
not influence the accuracy of the 3D reconstruction. A high-pass red filter was also used
to reduce light absorption by red blood cells.
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3.1.1 Sample preparation

To prepare the red blood cell samples, three media were prepared: an isotonic buffer
solution containing 1 mg of Bovine Serum Albumin (BSA) per mL of Phosphate-buffered
Saline (PBS), with an approximate osmolality of 290 mOsm/kg; a hypotonic solution,
which is a dilution of the isotonic solution in deionized water in a ratio of 70% solution
and 30% water and has an approximate osmolality of 200 mOsm/kg; and a hypertonic
solution, which was produced by adding 3.21 mg of NaCl to each mL of the original
isotonic solution, resulting in an osmolality of approximately 400 mOsm/kg.

Figure 14 – Change in cell morphology due to the osmolality of the medium. From left to right, we have a
red blood cell in hypotonic, isotonic, and hypertonic solutions. adapted from [27].

Sample preparation was the same regardless of the medium chosen: first, 1 mL
of solution is placed in an Eppendorf tube. Add 2 µL of blood taken from a student at
the time of the experiment to this tube, and homogenize the solution by shaking gently.
Place 700 µL of the medium in another Eppendorf tube, along with 200 µL of the blood
solution prepared in the first Eppendorf tube. The solution is then homogenized with the
help of a micropipette. From the final solution, 600 µL are collected with the micropipette
and added to a glass bottom dish, which is then placed on the microscope sample holder.
One must wait 15 minutes for the red blood cells to settle before starting the experiment.

During the experiment, two captures are made for each cell: one at minimum
contrast, and another with a defocusing of 2µm. In addition to the cell images, a background
capture is also made, an area without the presence of cells that is used later to correct
camera sensor fluctuations and other constant imperfections in the system. The background
correction is performed using the following expression:

IC = I

Bg
× ⟨Bg⟩ , (3.1)

in which IC is the corrected image, I is the original image, Bg is the background image,
and ⟨Bg⟩ is the average value of the background. Image 15 shows the difference between
an image before and after correction.



Chapter 3. Methodology 42

(a) Before correcting background. (b) After correcting background.

(c) Background collected and
used for correction.

Figure 15 – Comparison between images before and after correction of the background, together with the
background used

A quantitative way to verify the importance of background correction is to analyze
the variation in gray level along the marked line on the images 15a and 15b as shown in
Figure 16.

Figure 16 – Gray level comparison.
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On average, the experiments last between two and two and a half hours, during
which time the red blood cells maintain their stable geometry. After this time, degradation
occurs on their surface, with the appearance of roughness. The experiments were carried
out at 37°C with CO2 control at 5%.

3.2 Computer processing

The images were processed on a laptop with an Intel i7-9750H processor, NVIDIA
GeForce GTX 1660 Ti graphics card, and 16 GB of RAM, using the Python programming
language.

Once the images with corrected backgrounds were obtained, the OpenCV library
was used to import the images, which were then converted to contrast. To find the region
in the image where the cell is located, the radial derivative was used on the defocused
image contrast, and the coordinates with the maximum derivative were understood as the
cell outline, as shown in Figure 17.

Figure 17 – Example of detected contour.

Due to discontinuities found at the edges of the cell, as we go from cell to background,
it is convenient to reduce the contour used to define the region of interest. This is done
using a scaling algorithm, and the ratio used may vary from cell to cell, depending on the
characteristics of each one. In general, a ratio between 80% and 90% was used. Figure 18
shows an example of the new region explored in the cell.
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Figure 18 – Example of the new region explored in the figure.

Once the region of interest has been identified, the numpy library is used to solve
the equations for the thickness H(ρ) and ξ(ρ), which are 2.109 and 2.110 respectively,
using the fast Fourier transform algorithm. The approximate radius of the red blood cell is
obtained using the Hough transform on the defocused image, an algorithm used to identify
circles in images, using the OpenCV library.

With the thickness and asymmetry, we then obtain the total 3D reconstruction by
writing h1 = (ξ + H)/2 and h2 = (ξ − H)/2. The cell volume is found by integrating the
thickness. Mathematically:

V =
∫

H(x, y)dxdy. (3.2)

The area of each surface is found using the equation:

Ahi
=
∫ 1 +

(
∂hi

∂x

)2

+
(

∂hi

∂y

)2
1/2

dxdy (3.3)

where i = 1, 2. The total surface area of the cell is then the sum of the areas,
AT = Ah1 + Ah2 . With the volume and area, we can calculate the sphericity index χ [28],
which compares the profile of the red blood cell to a sphere. It is calculated using the
equation:

χ =
3
√

36πV 2

A
. (3.4)

The sphericity index has values between 0 and 1, with 1 being a sphere.
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4 Results

4.1 Reconstruction of a simulated red blood cell

From the surface shown on image 10, we can use the traditional contrast equation
2.66 to generate the contrast at two different focal planes, shown in the figure 19.

(a) Contrast image at df=0µm. (b) Contrast image at df=2µm.

Figure 19 – Contrasts of the simulated surface of a red blood cell. a) In the position of lowest contrast
and b) defocused by 2 µm

We can see that the simulated contrast image shown in image 19b is visually very
different from that shown in image 15b, an image with the same defocus. We can draw a
horizontal line through the middle of the cell to better observe this difference, as shown in
figure 20.
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Figure 20 – Comparison between simulated and real contrasts of a red blood cell. In a) we have both
contrasts at df = 0µm, and in b) at df = 2µm

To approximate our simulated contrast image, we can use the method presented
in section 1.3 and convolve the contrast with the microscope’s pupil function, which is
approximated by an Airy disk. Several radii were tested for the pupil function, three of
which are shown on figure 21. The aperture radius used was calculated with equation
2.143.
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Figure 21 – Comparison between the effect of different pupil functions on the simulated contrast image.
In a) we have a pupil with a cutoff frequency f0 = 6, 85 × 105m−1, smaller than that observed
in the system; in b) a pupil with a cutoff frequency f0 = 6, 3 × 105m−1, closer to the actual
pupil; and in c) a pupil with a cutoff frequency f0 = 5, 1 × 105m−1, larger than that observed.

The pupil chosen as ideal for the work was the one with f0 = 6, 3 × 105m−1. The
exit aperture of the objective lens used has a radius of approximately 0.5 cm, resulting in a
cutoff frequency f0 = 2.5 × 106m−1. This tells us that there are other objects in our optical
system that limit our resolution, generating greater diffraction and lower resolution. The
image of the contrasts at the defocusing of df=0µm and df=2µm is shown on figure 22.

(a) Contrast at df=0µm. (b) Contrast at df=2µm.

Figure 22 – Contrasts of the simulated surface of a red blood cell after convolution.

With those images in hand, we can use them to solve equation 2.69 for thickness
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using the computational Fourier transform, and equation 2.71 for asymmetry using the
finite element method, discussed in [29].

For thickness, we obtain:

Figure 23 – Comparison of the H thicknesses obtained by solving 2.69 using the images at 22. In a) we
have the thickness we expected to obtain again, in b) what we obtain when solving equation
2.69 with the calculated contrasts, and in c) the subtraction of the expected value from the
obtained value.

For asymmetry, the solutions obtained are extremely sensitive to contour conditions,
as shown on the image below.
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Figure 24 – Difference between asymmetries obtained when solving equation 2.71 with a small variation
in the boundary condition.

The high dependence on contour conditions, which cannot be reliably obtained
from the image, motivated the search for other ways to solve this problem. This led us to
an improved model for the angular spectrum of a phase object and a new expression for
contrast.

4.1.0.1 Contrast with refined expression

With the new contrast expression given by equation 2.108, we can again generate
the contrast of the phase object with the simulated surface. Again, we convolve the contrast
with the chosen pupil function.

(a) New contrast at df=0µm. (b) New contrast at df=2µm.

Figure 25 – Contrasts of the simulated surface of a red blood cell generated with the expression 2.108.

Compared to the contrast previously used:
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Figure 26 – Comparison between contrasts generated by expressions 2.66 and 2.108. In a) we have the
comparison at df = 0µm, and in b) at df = 2µm

We then realize that the contrast calculated via the traditional expression, shown
in figure 22, and the one calculated via the new expression, figure 25, are extremely similar,
so the contrast generated by the new expression is also very similar to the real one, as
shown on figure 27.

Figure 27 – Comparison between a real red blood cell contrast and the one generated by 2.108. In a) we
have the comparison at df = 0µm, and in b) at df = 2µm

With the contrasts, we can solve equations 2.109 for thickness and 2.110 for
asymmetry, both using the fast Fourier transform in a Python program, which can be
found in the appendix of this dissertation. Solving for thickness:
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Figure 28 – Comparison of the H thicknesses obtained. In a) we have the thickness we expected to obtain
again, in b) what we obtain when solving equation 2.109 with the calculated contrasts, and in
c) the subtraction of the expected value from the obtained value.

The thickness was obtained in 0.02s. Looking at the results, we can see on figure
28c) that most of our error is at the edges. This is because the solution obtained by
solving the equation for thickness is continuous in its derivative with respect to ρ, while
the generated surface goes to zero suddenly at the edges. If we analyze only the center, we
observe a difference of approximately 5%, or 0.04µm, between the profiles and the original
thickness, demonstrating the effectiveness of the method.

With the thickness, we can calculate the asymmetry from equation 2.110:
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Figure 29 – Comparison of the asymmetries ξ obtained. In a) we have the asymmetry we expected to
obtain again, in b) what we obtain when solving equation 2.110 with the calculated contrasts,
and in c) the subtraction of the expected value from the obtained value.

Once again, the results were obtained in approximately 0.02s. As in the case of
thickness, we can see on Figure 29c) that most of the error obtained is at the edges,
again due to the discontinuity of the derivative with respect to ρ in the asymmetry of the
generated surface. On the center, an average difference of approximately 5% was observed,
this time with a value of 0.08µm.

With the asymmetry and thickness obtained again, we can obtain our surface:
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Figure 30 – Surface reconstructed from equations 2.109 and 2.110, with contrasts shown in 25.

The complete program, from surface generation to reconstruction with the generated
contrasts, ran in 0.43 seconds.

4.2 Reconstruction of real red blood cells

With the proof of concept carried out on simulated red blood cell surfaces, we can
now move on to the reconstruction of real red blood cells. Three media with different
osmolalities were used. In the isotonic medium, approximately 30 red blood cells were
analyzed, and in the hypotonic and hypertonic media, approximately 25 red blood cells
were analyzed in each.

Figure 31 shows the reconstruction of a red blood cell in isotonic medium:
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Figure 31 – Three-dimensional reconstruction of a red blood cell in isotonic medium. In a) we have the
image of the red blood cell with a defocusing of 2µm, in b) its thickness obtained from
equation 2.109, in c) its asymmetry obtained with equation 2.110, in d) a transversal view of
the reconstructed red blood cell, and in e) the total three-dimensional reconstruction of the
red blood cell. The edges of the surfaces were artificially joined for better visualization. Red
blood cell data: R = 3, 7µm, A = 123, 8µm2, V = 91, 5fL, χ = 0, 69.

On figure 32 below, we show the reconstruction of another red blood cell in isotonic
medium, this one with an unusual shape:
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Figure 32 – Three-dimensional reconstruction of an unusually shaped red blood cell in an isotonic medium.
In a) we have the image of the red blood cell with a defocusing of 2µm, in b) its thickness
obtained from equation 2.109, in c) its asymmetry obtained with equation 2.110, in d) a
transversal view of the reconstructed red blood cell, and in e) the total three-dimensional
reconstruction of the red blood cell. The edges of the surfaces were artificially joined for better
visualization. Red blood cell data: R = 3, 8µm, A = 131, 9µm2, V = 84, 9fL, χ = 0, 71.

On Figure 33, we have a standard red blood cell in a hypotonic medium:
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Figure 33 – Three-dimensional reconstruction of a red blood cell in a hypotonic medium. In a) we have
the image of the red blood cell with a defocusing of 2µm, in b) its thickness obtained from
equation 2.109, in c) its asymmetry obtained with equation 2.110, in d) a transversão view of
the reconstructed red blood cell, and in e) the total three-dimensional reconstruction of the
red blood cell. R = 3, 5µm, A = 107, 8µm2, V = 81, 7fL, χ = 0, 85.

And on figure 34, we have another red blood cell in a hypotonic medium:
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Figure 34 – Three-dimensional reconstruction of a red blood cell in a hypotonic medium. In a) we have
the image of the red blood cell with a defocusing of 2µm, in b) its thickness obtained from
equation 2.109, in c) its asymmetry obtained with equation 2.110, in d) a transversal view of
the reconstructed red blood cell, and in e) the total three-dimensional reconstruction of the
red blood cell. The edges of the surfaces were artificially joined for better visualization. Red
blood cell data: R = 3, 7µm, A = 131, 4µm2, V = 106, 2fL, χ = 0, 81.

On figure 35, we have a red blood cell in a hypertonic medium with the expected
geometry:



Chapter 4. Results 58

Figure 35 – Three-dimensional reconstruction of a red blood cell in a hypertonic medium. In a) we have
the image of the red blood cell with a defocusing of 2µm, in b) its thickness obtained from
equation 2.109, in c) its asymmetry obtained with equation 2.110, in d) a transversal view of
the reconstructed red blood cell, and in e) the total three-dimensional reconstruction of the
red blood cell. The edges of the surfaces were artificially joined for better visualization. Red
blood cell data: R = 2, 2µm, A = 123, 3µm2, V = 75, 2fL, χ = 0, 69.

And on figure 36, another red blood cell in a hypertonic medium:
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Figure 36 – Three-dimensional reconstruction of a red blood cell in a hypertonic medium. In a) we have
the image of the red blood cell with a defocusing of 2µm, in b) its thickness obtained from
equation 2.109, in c) its asymmetry obtained with equation 2.110, in d) a transversal view of
the reconstructed red blood cell, and in e) the total three-dimensional reconstruction of the
red blood cell. R = 3, 5µm, A = 124, 2µm2, V = 75, 4fL, χ = 0, 69.

We also obtained the average volumes VM , average total areas AM , average radii
RM , and average sphericity index χM of all red blood cells analyzed. The data were
organized in the table below, and errors were calculated based on the standard deviation
of the measurement.
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Media VM(µm3) AM(µm2) RM(µm) χM

Hypotonic 118 ± 26 136 ± 16 3, 6 ± 0, 3 0, 84 ± 0, 07
Isotonic 87 ± 14 138 ± 14 3, 7 ± 0, 5 0, 68 ± 0, 05

Hypertonic 90 ± 10 152 ± 10 3, 7 ± 0, 3 0, 64 ± 0, 04

Analyzing the table, it can be observed that, in general, the results are consistent with
those observed in the literature [19], [28] [30]. There was no significant variation between
the volume values found in red blood cells in isotonic and hypertonic solutions, contrary
to expectations, which may have been due to errors in the preparation of the hypertonic
solution, since there was no osmometer available to measure its osmolality. Another
possibility is that the solutions were prepared correctly, but in order to observe the
osmotic shock more intensely, we should have used a hypertonic solution with even higher
osmolality.
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5 Conclusion

In this dissertation, we presented the refinement of the model for the angular
spectrum of a phase object to be used in defocusing microscopy, as well as its use to create
a new expression for the contrast used in the technique. Along with the new expression for
contrast, we showed how we can use the surface of an ellipsoid, adjusted so that the surface
has a geometry similar to that of a red blood cell, to assist us in testing and validating
the computational routine developed for the three-dimensional reconstruction of red blood
cells.

With the geometric model, it was possible to visualize the difference between the
traditional contrast equation 2.66 and the new one 2.108, and between these and the
contrast of a real red blood cell. It was also possible to observe the problems that previously
existed with the solution of equation 2.71, which was very sensitive to boundary conditions
that cannot be accurately found via experiment.

With the new expression, we were able to perform three-dimensional reconstruction
of red blood cells extremely quickly and reliably, taking 0.4 seconds, about 25 times faster
than previously presented using the finite element method, as presented in José Maria
Caquito’s dissertation [29].

With the considerable speed improvement obtained with the new model and
computational routine, we can envision that, in the near future, real-time reconstruction
will be possible, with the two images in different focal planes being obtained simultaneously
in the microscope with the aid of an external module. This also opens up the possibility of
analyzing the morphology of red blood cells in dynamic processes, such as when they are
stressed by optical tweezers. In addition, the technique may become a means of diagnosing
sickle cell anemia, a disease that severely alters the shape and dynamics of the affected
red blood cells.

The next steps in the work will be to improve the computational routine in order
to enable the reconstruction of red blood cells with images obtained simultaneously under
the microscope. The analysis of red blood cells in dynamic situations and the application
of the theory to other types of cells, such as macrophages and cardiomyocytes, are also of
interest.
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APPENDIX A – Code for the 3D
reconstruction of red blood cells

1

2 from mpl_toolkits import mplot3d
3 import cv2
4 import numpy as np
5 import time
6 import matplotlib.pyplot as plt
7 from matplotlib import cm
8 import seaborn
9

10 time_start = time.time() # begins the time counter
11

12 #%% Reading images with corrected background
13 # The name of the archives needs to be substituted between the ''
14 img_d0 = np.uint8(cv2.imread('26_00-1.tif',2))
15 img_d2 = np.uint8(cv2.imread('26_02-1.tif',2))
16

17 # Contrast calculation
18

19 C0 = (img_d0.astype(float)-np.mean(np.mean(img_d0)))/np.mean(np.mean(img_d0))
20 C2 = (img_d2.astype(float)-np.mean(np.mean(img_d2)))/np.mean(np.mean(img_d2))
21 C=(C2-C0)
22

23 #%% Parameters
24 df_1 =0 # defocus of each image
25 df_2 =2
26 nm = 1.333 # media refractive index
27 nc = 1.391 # red blood cell refractive index
28 nob = 1.51 # objective lens oil refractive index
29 pixelsize = 0.064 # size of the camera's pixel
30 df = df_2 - df_1 # relative defocus between images
31 width,height = img_d2.shape[:2] # image size parameters
32

33 #%% Finding the cell's contour
34 img_blur = cv2.GaussianBlur(C2,(3,3),0)
35

36 # derivatives so we can find the borders
37 scharrx = cv2.Scharr(img_blur,ddepth=-1, dx=1,dy=0)
38 scharry = cv2.Scharr(img_blur,ddepth = -1,dx=0,dy=1 )
39 scharrXY = np.sqrt(scharrx**2+scharry**2)
40 scharrXY8 = np.uint8(scharrXY)
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41

42 ret,thresh = cv2.threshold(scharrXY8,0,255,cv2.THRESH_BINARY)
43

44 contours, hierarchy = cv2.findContours(image=thresh, mode=cv2.RETR_EXTERNAL,
45 method=cv2.CHAIN_APPROX_NONE)
46

47 img_copy = C.copy()
48

49 inside = np.zeros_like(C)
50 cv2.drawContours(inside, contours,-1,1,-1 )
51

52 inside = np.uint8(inside)
53

54 cnt,hier = cv2.findContours(inside, mode = cv2.RETR_EXTERNAL,
55 method = cv2.CHAIN_APPROX_NONE)
56

57 area = []
58

59 for i in cnt:
60 a = cv2.contourArea(i)
61 area.append(a)
62

63 index = np.argmax(area)
64

65 inside2 = np.zeros_like(inside)
66 cv2.drawContours(inside2, cnt, index, 1, -1)
67

68 inside2 = np.uint8(inside2)
69

70 cnt2, hier2 = cv2.findContours(inside2, mode = cv2.RETR_EXTERNAL,
71 method = cv2.CHAIN_APPROX_NONE)
72

73 #%% If needed, we can alter the size of the contour manually
74

75 inside2 = np.uint8(inside2)
76 cnt2, hier2 = cv2.findContours(inside2, mode = cv2.RETR_EXTERNAL,
77 method = cv2.CHAIN_APPROX_NONE)
78

79 cntF = cnt2[0]
80 M = cv2.moments(cntF)
81 cx = int(M['m10']/M['m00'])
82 cy = int(M['m01']/M['m00'])
83

84 cnt_norm = cntF - [cx,cy]
85

86 scale = 0.80 # sclae of the new contour relative to the one detected previously
87 cnt_scaled = cnt_norm * scale
88
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89 cnt_scaled = cnt_scaled + [cx,cy]
90 cnt_scaled = np.int32(cnt_scaled)
91

92 pre_inside = np.zeros_like(C)
93

94 cv2.drawContours(pre_inside,cnt_scaled,-1,1,3)
95

96 pre_inside = np.uint8(pre_inside)
97

98 cntFinal, hierF = cv2.findContours(pre_inside, mode =cv2.RETR_EXTERNAL,
99 method = cv2.CHAIN_APPROX_NONE)

100

101 insidef = np.zeros_like(C)
102

103 cv2.drawContours(insidef, cntFinal,-1,1,-1)
104

105 insidef[insidef==0] = np.nan
106

107 #%% Thickness profile
108

109 start_H = time.time()
110

111 # q^2 parameter construction
112 freq_x = np.fft.fftfreq(C.shape[0], pixelsize)
113 freq_y = np.fft.fftfreq(C.shape[1], pixelsize)
114

115 qxn = 2*np.pi*freq_x
116 qyn = 2*np.pi*freq_y
117

118 mqyn, mqxn = np.meshgrid(qyn,qxn)
119 Q2n = (mqxn*mqxn) + (mqyn*mqyn)
120 Q2n[0,0]=1
121

122 FdC = np.fft.fft2(C) # Fourier trtansform of the Delta C
123

124 FQ2 = FdC/Q2n
125

126 termoH = (2*nob*nm)/(df*(nm**2-nc**2)) # scalar term of the thickness profile expression
127

128 H = termoH * np.fft.ifft2(FQ2) # Thickness profile
129

130 H = H.real
131 H = H + np.abs(np.amin(H))
132

133 end_H = time.time()
134

135 time_H = end_H - start_H # time spent on the calculation of H
136
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137

138 # 3d surface plot
139 H_inside = insidef * H
140 Ny = C.shape[0]
141 Nx = C.shape[1]
142

143 X = np.arange(-Nx/2, Nx/2) * pixelsize
144 Y = np.arange(-Ny/2, Ny/2) * pixelsize
145 X,Y = np.meshgrid(X,Y)
146

147

148 fig = plt.figure()
149 ax = fig.add_subplot(projection='3d')
150 ax.set_xlabel('µm')
151 ax.set_ylabel('µm')
152 ax.set_zlabel('µm')
153

154 ax.set_xlim3d(-4.5, 4.5)
155 ax.set_ylim3d(-4.5, 4.5)
156 # ax.set_zlim3d(-4, 0)
157 plt.title('Thickness profile')
158

159 surf = ax.plot_surface(X, Y, H_inside, cmap=cm.viridis,
160 linewidth=0, antialiased=False)
161

162 #%% Asymmetry
163

164 start_A = time.time()
165

166 termoA = (4*(nm**2))/((nm**2-nc**2)) # scalar term of the asymmetry expression
167

168 FC0 = np.fft.fft2(C0) # contrast Fourier transform
169

170 FC0Q2 = FC0/Q2n
171

172 HA = termoA * np.fft.ifft2(FC0Q2)
173

174 HA = HA.real
175

176 A = HA / H # Asymmetry
177

178 end_A = time.time()
179

180 tempo_A = end_A-start_A # time spent on the calculation of the asymmetry
181

182 HA_inside = HA * insidef
183 A_inside = HA_inside / H_inside
184 # plot 3d da assimetria
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185

186

187 fig = plt.figure()
188 ax = fig.add_subplot(projection='3d')
189 ax.set_xlabel('µm')
190 ax.set_ylabel('µm')
191 ax.set_zlabel('µm')
192

193 ax.set_xlim3d(-4.5, 4.5)
194 ax.set_ylim3d(-4.5, 4.5)
195 # ax.set_zlim3d(-4, 0)
196 plt.title('Assimetria')
197

198 surf = ax.plot_surface(X, Y, A_inside, cmap=cm.viridis,
199 linewidth=0, antialiased=False)
200

201 # Construction of the srfaces h1 and h2
202

203 h1 = (A_inside + H_inside)/2
204 h2 = (A_inside - H_inside)/2
205

206 #Joining the edges of the surfaces for better visualization
207

208 edge = np.zeros_like(C)
209 cv2.drawContours(edge, cnt_scaled, -1,1,3)
210

211 edge_h1 = edge * h1
212 edge_h2 = edge * h2
213

214 mean = (edge_h1 + edge_h2)/2
215

216 h11 = h1.copy()
217 h22 = h2.copy()
218

219 h11[mean != 0] = mean[mean!=0]
220 h22[mean != 0] = mean[mean!= 0]
221

222 # Surface plot
223

224 fig = plt.figure()
225 ax = fig.add_subplot(projection='3d')
226 ax.set_xlabel('µm')
227 ax.set_ylabel('µm')
228 ax.set_zlabel('µm')
229

230 # ax.set_xlim3d(-4.5, 4.5)
231 # ax.set_ylim3d(-4.5, 4.5)
232 # ax.set_zlim3d(-4, 4)
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233 plt.title('Total 3D reconstruction')
234

235 surf = ax.plot_surface(X, Y, h11, cmap=cm.Reds,
236 linewidth=0, antialiased=False)
237 surf = ax.plot_surface(X, Y, h22, cmap=cm.Blues,
238 linewidth=0, antialiased=False)
239

240 #%% Transversal view plot
241

242 mid = int(width/2)
243

244 h11_meio = h22[mid]
245 h22_meio = h11[mid]
246

247 x = np.linspace(0,width, width)
248 x = np.around(x)
249

250 fig = plt.figure()
251 ax = plt.gca()
252 plt.plot(x,h11_meio, color = 'red')
253 plt.plot(x,h22_meio, color ='blue')
254 plt.title('Transversal view')
255 plt.show()
256

257 #%% Radius calculation
258

259 inside_circle =insidef.copy()
260 inside_circle[np.isnan(inside_circle)]=0
261 img = np.uint8(inside_circle * img_d2.copy())
262 circles = cv2.HoughCircles(img,cv2.HOUGH_GRADIENT,1,20,
263 param1=50,param2=30,minRadius=0,maxRadius=0)
264 circles = np.round(circles[0, :]).astype("int")
265

266 coord_circ = circles[0]
267

268 raio = coord_circ[2] * pixelsize
269

270 #%% Volume calculatiion
271

272 H_calc = H * inside_circle
273 Volume = np.trapz(np.trapz(H_calc,x=None, dx = pixelsize, axis = -1),
274 x=None, dx = pixelsize, axis = -1)
275

276 #%% Surface Area and sphericity calculation
277

278 h1_calc = h11*inside_circle
279 h2_calc = h22*inside_circle
280
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281 h1_d = np.gradient(h1_calc,pixelsize,pixelsize,axis=[0,1])
282 h1_d2 = np.sqrt(1+h1_d[0]**2+h1_d[1]**2)
283 h1_d2[np.isnan(h1_d2)]=0
284 h1_d2[h1_d2==1.] = 0
285 area_h1 = np.sum(np.sum(h1_d2)) * pixelsize*pixelsize
286

287 h2_d = np.gradient(h2_calc,pixelsize,pixelsize,axis=[0,1])
288 h2_d2 = np.sqrt(1+h2_d[0]**2+h2_d[1]**2)
289 h2_d2[np.isnan(h2_d2)]=0
290 h2_d2[h2_d2==1.]=0
291 area_h2 = np.sum(np.sum(h2_d2)) * pixelsize*pixelsize
292

293 total_area = area_h1+area_h2
294

295 sphericity = (36*np.pi *Volume**2)/total_area
296

297 end_time = time.time()
298

299 total_time= end_time - start_time # total time
300
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APPENDIX B – ImageJ guide for the 3D
reconstruction of red blood cells

To begin, we need two images of red blood cells with a relative defocusing of
∆zf = 2µm and the plugin “DivideQ2.class”, which was made available by U. Agero in [6].
To install the plugin, we must perform the “Plugins →Install” process and select the file
containing the plugin.

With the images, the first thing we must do is convert them from grayscale to
contrast. Contrast can be given by C = (I − I0)/I0. To measure I0, we set up ImageJ
to “Analyze →Measure” and measure the average gray value for each image. We must
now convert the images to 32bit. We do this using the command “Image →Type →32bit”.
With the images in 32bit, we calculate the contrasts using “Process →Math →Subtract”
and “Process →Math →Divide” with the values previously measured for I0.

The next step is to calculate the thickness profile of the red blood cell. As previously
shown, the thickness can be calculated using equation 2.109. To do this, we must first
subtract one image from the other. We do this using “Process →Image Calculator” and
choosing the images for subtraction. It is important that the boxes “Create a new window”
and “32-bit (float) result” are checked. Mathematically, we have:

∆C = (n2
m − n2

c)∆zf

2nmn0
∇2H. (B.1)

We must now calculate the scalar term accompanying the Laplacian of the thickness.
nm is the refractive index of the medium, nc is the index of the red blood cell, n0 is that
of the oil used in the objective lens, and ∆zf is the relative defocus between the images.
The values generally used are nm = 1.333, nc = 1.391, n0 = 1.51 and ∆zf = 2. Thus, the
term is ≈ 0.078. We must then divide ∆C by −0.078. We do this using “Process Math
→Divide”. To condense the notation, we will do (n2

m−n2
c)∆zf

2nmn0
= α. Now, we have:

∆C

α
= ∇2H. (B.2)

Let’s solve this differential equation using the Fourier transform method. We will
use the Hartley transform H, since we are only interested in the real part of the transform.
To select the Hartley transform, we use the option “Process →FFT →FFT Options” and
select only the box “Fast Hartley Transform.” Running “Process →FFT →FFT” gives us:
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1
α

H[∆C] = q2H[H]. (B.3)

The Fourier transform inverts the quadrants of the image, so before the next step
we must do “Process →FFT →Swap Quadrants”. Now, we must use the plugin ‘DivideQ2’.
We do this with the command “Plugins →DivideQ2”. Now we have:

H
[

∆C

αq2

]
= H[H] (B.4)

We must now calculate the inverse transform, which for the Hartley transform is
equal to the direct transform. We use “Process →FFT →FFT” again, and then we must
change the quadrants to their original location by executing “Process →FFT →Swap
Quadrants.” We are left with:

H
[
H
[

∆C

αq2

]]
= H (B.5)

Now we must normalize our image, since Hartley transform normalization has not
been performed. To do this, we must divide our image by the window size N twice, since
we are performing the operation in two dimensions. Since the “DivideQ2” plugin is in
pixels, we must also multiply the image by the camera pixel size p twice to find the value
of H in micrometers. Doing this, we finally have:

H = p2

αN2 H
[
H
[

∆C

αq2

]]
(B.6)

Finally, we have found the thickness profile of our red blood cell. Now, let’s find
the asymmetry, given by equation 2.110.

According to the theory of defocusing microscopy, the contrast is given by:

C = |n2
m − n2

c |
4n2

m

∇2
[
Hξ + 2nm

n0
zfH

]
(B.7)

Now choose one of the images used previously, preferably the one with the greatest
defocusing. Divide the image by the term |n2

m−n2
c |

4n2
m

= β, using the command “Process →Math
→Divide”. Using the same values from the thickness calculation, we have β ≈ 0.022. We
are left with:

C

β
= ∇2

[
Hξ + 2nm

n0
zfH

]
(B.8)
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Again, let’s calculate the Hartley transform by doing “Process →FFT →FFT”,
and let’s invert the quadrants using “Process →FFt →Swap Quadrants”. At the moment
we have:

1
β

H[C] = q2H
[(

Hξ + 2nm

n0
zfH

)]
(B.9)

Now we use the plugin “DivideQ2” by going to “Plugins→DivideQ2”. Then we
have:

1
βq2 H[C] = H

[(
Hξ + 2nm

n0
zfH

)]
(B.10)

We can now perform the Hartley transform again using “Process →FFT →FFT”,
followed by returning the quadrants to their original state using “Process →FFT →Swap
Quadrants”. We are left with:

H
[

1
βq2 H[C]

]
=
(

Hξ + 2nm

n0
zfH

)
(B.11)

We must now perform the same normalization as before, dividing twice by the
window size and multiplying twice by the pixel size:

p2

N2 H
[

1
βq2 H[C]

]
=
(

Hξ + 2nm

n0
zfH

)
(B.12)

Finally, we divide the image by the one obtained previously for the thickness profile,
running “Process →Image Calculator” and selecting the two images. We are left with:

ξ + 2nm

n0
zf = p2

HN2 H
[

1
βq2 F [C]

]
(B.13)

Finally we have obtained both the thickness profile and asymmetry. We can calculate
each membrane by doing "Process →Image Calulator" and adding or subtracting H and ξ.
After that, we just need to divide each image by two using "Process →Math →Divide",
and we have the images for both membranes. To display both membranes individually, we
need to execute "Analyse →Surface plot".
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